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Chapter  1

Inside Revit Structure

The Revit Structure interface is designed to be an easy-to-use, organized presentation of com-
mands and drawing areas. The basic interface is highly configurable and can be adapted to fit 
most working needs that may arise as you interact with the computer in order to create a model. 
Multiple model views can be open at once so that you can see plan, section, elevation, and model 
views of an element side by side in the drawing area at one time.

This chapter will explore the interface and the arrangement of menus, toolbars, tabs, and 
other tools available to you in the Revit Structure workspace. The tools found here will be used 
to model and document your virtual structure, and also help you to achieve a building informa-
tion modeling (BIM) solution for your project.

Underlying the graphical interface is a robust database that coordinates the graphical infor-
mation through the use of a parametric change engine that controls the display of all elements 
in your project. In this way, a change in an element that takes place in a plan or a section view is 
immediately propagated to all views in the project, which in turn save lots of time for you and 
allows you to focus on the design of the structure rather than the busywork of having to edit 
many views in order to correct one element, as occurs in most 2D drafting programs.

To succeed in this venture, you will need to add many tools to your tool chest. Imagine a con-
struction worker who goes to work with only a hammer and a screwdriver. In all likelihood the 
worker will not be able to get much accomplished. So to get started, you need to add the neces-
sary tools to your own tool chest so that you can work effectively in the virtual model-building 
environment.

Once you have learned the basics of the various display and modeling tools available to you 
in Revit Structure, you will be ready to move on to the actual modeling process in the subsequent 
chapters of this book.

In this chapter you will learn to:

Use the graphical user interface•u	

Understand the types of elements in the modeling environment•u	

Create and manage project views•u	

Control the graphical display of elements in a project•u	
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4  | Chapter  1  Inside Revit Structure

Using the Graphical User Interface (GUI)
When you double-click the Revit Structure 2009 icon on your desktop, you open the preview 
dialog box. This dialog box shows projects and families on which you have recently been work-
ing. Click one of the existing file icons to open them, or click New to begin a new project (see 
Figure 1.1). 

If you click New, the New Project dialog box will appear. In that dialog box you either choose to 
create a new project template or use a specific project template. Click OK, and then Revit Structure 
puts you into the main graphical user interface (GUI).

The Revit Structure GUI (see Figure 1.2) is task oriented, with a compact footprint and semi-
rigid structure. The task-oriented layout and grouping of like commands makes project man-
agement and modeling within Revit Structure logical and efficient. The compact footprint of the 
GUI is due in large part to the lack of excessive toolbars and dialog boxes, which tend to clutter 
other platforms. This allows a large area in which to work and view the model. The location and 
size of most GUI components are reset to their defaults when you restart Revit Structure, mak-
ing the interface somewhat rigid with regard to user customization.

The GUI (see Figure 1.2) contains a menu bar, toolbars, Options bar, Type Selector, Design 
bar, Project Browser, drawing area, View Control bar, and a status bar, all described in the fol-
lowing sections.

Figure 1.1 
Opening dialog box 
with graphical file 
display
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Using the Graphical User Interface (GUI) |  5

Menu Bar
The standard Microsoft Windows-based menu bar (see Figure 1.3) is located at the top of the 
GUI and provides direct access to all of the commands and settings available in Revit Structure. 
Commands with defined shortcuts will have the shortcut key shown to the right of the command 
name in the menu.

Toolbars
The default Revit Structure toolbar layout (see Figure 1.4) is located directly below the menu 
bar and houses frequently used commands for file management, view navigation, and element 
modification. Toolbar and text label display is controlled from the menu bar: Window  Toolbars 
or the right-click context menu. Display can also be handled by editing the Revit.ini file, which 
will be discussed in a later chapter. Hiding all of the toolbars will completely remove the toolbar 
area from the interface. To show them again, you will need to go through the menu bar or edit 
the Revit.ini file.

Figure 1.2 
Default GUI with 
its intuitive dis-
play of commands

Figure 1.3 
The menu bar  
is an easy-to-use 
pull-down arrange-
ment of most  
commands.
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6  | Chapter  1  Inside Revit Structure

You can rearrange toolbars by left-click-dragging the divider located at the beginning of each 
toolbar. While toolbar and text label display is stored, the arrangement of the toolbars is not. All 
toolbars set to display will be reset to their default positions when you restart Revit.

Options Bar
The Options bar (see Figure 1.5) is located directly under the toolbars and displays options spe-
cific to the active command or selected element(s). These options can be huge time-savers by 
negating the need to dig through a dialog box or launch another command. Even experienced 
users can increase productivity by keeping a watchful eye on the constantly changing Options 
bar and making use of the controls provided. The location of the Options bar above the display 
area makes it easier for the eyes to notice changes. You do not have to keep glancing up and 
down as much as you do in other applications.

Wish Granted Courtesy of the Options Bar

Both beginner and experienced users of Revit Structure alike have uttered, “I wish Revit Structure 
could…” or “I wish Revit Structure had…” among other colorful expressions. These wishes can often 
be granted by simply looking to the Options bar. The following graphics illustrate the many looks of 
the Options bar during the execution of a single modeling command.

When you first invoke the Slab command, the default placement method is Pick Walls, and the Options 
bar shows various default options, as shown in the following graphic:

If you prefer to place the slab by sketching lines, you select the Lines command and the Options bar 
will change, as shown here:

You finish the slab and select it in plan, and the Options bar now shows editing controls:

As you can see, the Options bar had three radically different configurations, each loaded with context-
specific controls that in many cases cannot be found anywhere else. In most cases, after you initiate a 
command you will want to look to the Options bar.

Figure 1.4 
The toolbars 
contains many 
frequently used 
commands.

Figure 1.5 
Keep an eye on the 
Options bar as its 
commands change.
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Using the Graphical User Interface (GUI) |  7

Type Selector
The Type Selector (see Figure 1.6) is located on the left end of the Options bar and lists all of the 
types available for a given element that are loaded into your project file. Generally you should 
only load in the types you need to use in order to keep the computer performance from slowing. 
The Load button is located conveniently close to the Type Selector so you can load in more types 
as they are needed.  Why load every type of wide flange steel beam into your project if you only 
need a W12x26 and a W18x40?

The Type Selector is used to select a specific element type for placement. If you highlight an 
element that has been placed in your project, you can then use the Type Selector to identify it or 
change its type—for instance, to change a W12x26 to a W18x40. Within your project views any 
existing beam tag for that member size will automatically change its corresponding value to the 
new type.

Design Bar
The Design bar (see Figure 1.7) is permanently docked along the left side of the GUI and con-
tains commands that are used for modeling, annotating, and viewing. These commands are 
organized into nine task-specific tabs: Basics, View, Architectural, Drafting, Rendering, Site, 
Massing, Modeling, and Construction.  The View, Drafting, and Modeling tabs contain the 
majority of the commands required to create and document a structural model. The Basics tab 
combines the most commonly used commands from these three tabs and is an ideal tab to have 
active for most modeling and annotation tasks.

In addition to the nine tabs, two context-specific tabs (Family and Sketch) will appear and 
remain active for the duration of certain commands. The Family tab is used to create and edit 
in-place and external families. The Sketch tab is used to create and modify a sketch and will be 
displayed on the Design bar when using the Slab or other sketch-based elements. 

Tab display is similar to toolbar display in that it is controlled from the menu bar: by choos-
ing Window  Design Bars or by right-clicking on the Design bar and selecting a tab name from 
the context menu. Tab display can also be handled by editing the Revit.ini file, which will be 
discussed later in Chapter 17. Adjust the width of the Design bar by left-click-dragging the right 
border. Tab display settings are remembered, but the width of the Design bar will be reset to its 
default when you restart Revit Structure. 

Figure 1.6 
The Type Selector
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8  | Chapter  1  Inside Revit Structure

Project Browser 
The Project Browser displays all of the views, families, groups, and Revit Structure links in a 
Windows Explorer–style format, and is located to the right of the Design bar (see Figure 1.8). 
The views in the Project Browser can be sorted, grouped, and filtered in a variety of ways 
depending on how you want to organize your project. The organization will be discussed more 
fully in the next chapter.

Unlike the Design bar, the Project Browser can be docked on the left (its default location), top, 
right, or bottom of the drawing area. You can also undock and resize it by left-click-dragging 
any of its borders to act as a floating dialog box. The Project Browser will return to its default 
location and size once you restart Revit.

Figure 1.7 
The Design bar 
houses tabs that 
organize your com-
mands.
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Using the Graphical User Interface (GUI) |  9

Exercise: Create a New Browser View Type: On Sheets

This exercise will step you through the process of creating a new browser view type. The new browser 
view type will be called On Sheets, and as the name suggests you will only be able to see views in the 
project that are placed on a sheet. While working on a project, numerous working, construction, and 
coordination views are typically created and can clutter the Project Browser, so this view type can be 
quite useful. 

This browser view type will allow you to easily view and work on only the views that are part of your 
construction documents.

	1.	 Start a new project.

	2.	 Select the Views heading in the Project Browser, as shown in this graphic:

Figure 1.8 
Project Browser

84404c01.indd   9 10/23/08   1:58:38 PM



10  | Chapter  1  Inside Revit Structure

	3.	 Click the Element Properties button to the right of the Type Selector, as shown here:

	4.	 From the Type drop-down menu in the Type Properties dialog box, select the Not On Sheets type.

	5.	 Click Duplicate, then type on sheets, as shown below, for the name and click OK to close the Name 
dialog box:

	6.	 Click the Edit button next to the Filter parameter.

	7.	 In the Browser Organization Properties dialog box, you will see that the Filter By drop-down menu 
is already set to Sheet Name, followed by a drop-down menu set to Equal To. 

	8.	 Change the Equal To drop-down menu to Not Equal To, as shown here, and click OK to close the 
dialog box:
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Using the Graphical User Interface (GUI) |  11

	9.	 Finish by clicking OK to close the Type Properties dialog box. Note that your browser is now sorted 
by your new browser view type as illustrated below:

You can change your browser view type at any time by selecting the Views heading in the Project 
Browser and selecting a different type from the Type Selector. The Revit default browser view type 
is All.

Drawing Area
The drawing area (see Figure 1.9) is where all open views are displayed. Multiple views of sev-
eral projects can be open at one time. Project templates and families can also be open in a single 
session of Revit and displayed in the drawing area. You can arrange all of these open views 
in the drawing area by using the Window menu bar in typical Windows fashion. All the view 
controls you would expect are here, including Tile, Cascade, and Arrange, which perform as you 
would expect.

Figure 1.9 
The drawing area 
contains all your 
open views, which 
can be arranged in 
many ways.
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12  | Chapter  1  Inside Revit Structure

Having many views open at once, though, can lead to a slower program response. The Close 
Hidden Windows command is quite important in managing the performance of Revit, especially 
when you are working on large or complex projects. With one view maximized in the drawing 
area, this command will close all but the last active view of each project, project template, and 
family that is currently open. 

Most views open maximized in Revit regardless of how they are triggered, so it is easy to 
quickly have numerous views of a project open at any given time without noticing it. Since Revit 
updates the display of all open views in real time, you can imagine how this can rapidly become 
a performance issue. Frequent use of this command is highly recommended and is a good can-
didate for addition to your shortcut list.

Presentation GUI

While most will find the default interface more than adequate for daily use, a few simple modifica-
tions can drastically change the look of the GUI to better serve other purposes or user preferences. The 
following graphic shows the interface with the Design bar and toolbars hidden and a floating Project 
Browser. This clean look is great for viewing and working with the model while in meetings with the 
design team and/or clients.
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Using the Graphical User Interface (GUI) |  13

Nice Postage Stamp Collection

I got a new PC recently and was working on a rather complex healthcare project. Impressed with the 
improvement in performance compared to my previous PC, I had not been paying attention to how 
many views I actually had open. The PC slowed considerably (a several-second pause instead of the 
expected near instantaneous response) while I was attempting a rather routine procedure. It was 
not until I tiled my open views a few commands later that I realized what the problem was: 25 open 
windows! They looked like a bunch of postage stamps.  As I began to use the Close Hidden Windows 
command, as shown in the following graphic, my PC’s performance returned to normal.

View Control Bar
The View Control bar (see Figure 1.10) is located on the bottom left of most views. The controls 
found on the View Control bar are for commonly used view and element display properties. 
Each button expands when you select it and displays several context-specific settings.  There are 
eigh main tabs on the bar:

Scale•u	

Detail Level•u	

Model Graphics Style•u	

Shadows•u	

Crop Entire View On or Off•u	

Crop a View Region•u	

Temporary Hide/Isolate•u	

Reveal Hidden Elements•u	
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14  | Chapter  1  Inside Revit Structure

Working views can change from minute to minute, for instance as you change between 
coarse and medium detail modes, so it is very convenient to have the View Control bar nearby 
for easy access to the controls.

Status Bar
The status bar is located at the very bottom of the GUI. The text on the left of the status bar will 
do the following:

Display the name of a highlighted element.•u	

Display prompts and/or additional information regarding the active command.•u	

List the available shortcuts that are available for a given sequence of characters, which can •u	

be navigated using the arrow keys.

On the right end of the status bar, you can view the status of your keyboard locks (Caps, 
Num, and Scroll). To the right of this is an element selection counter, which will display the 
number of elements currently selected in the drawing.

The Communication Center is located at the right end of the status bar and can be config-
ured to check for software updates, product support announcements, and other related news at 
intervals defined in its settings. The Communication Center can be opened by double-clicking 
or by right-clicking the icon.  In the Communicaton Center dialog box that is then displayed you 
configure which information channels you want to receive information about, such Articles and 
Tips, and at what interval you wish to update your local workstation with the information.

Shortcuts
Shortcuts are one of the most powerful ways to increase your overall speed and productivity 
when using Revit Structure. Shortcuts enable you to launch commands directly from the draw-
ing area without having to move your cursor. That significantly reduces mouse travel, saving 
time and your wrist. Many shortcuts are already defined, and you can create others for nearly 
all commands found within the menu bar.

Right-Click, or Context, Menu
The right-click, or context, menu provides quick access to useful commands directly related to 
the element or object being highlighted. As previously discussed, right-clicking on GUI objects 
(toolbars and the Design bar) displays a menu that controls how they are displayed: 

Right-clicking in the empty space of a view displays a menu (see Figure 1.11) with view •u	

navigation commands and access to the properties of the view. 

Right-clicking different elements in the model will also display various menus (see •u	

Figures 1.12 and 1.13) with access to element- and view-specific commands and properties.

Figure 1.10 
The View Control 
bar makes it easy 
to control the view 
display.
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Now that you have had a good look at the basic Revit Structure interface and command lay-
out, let us explore the various elements that these commands create and manage in the creation 
of your building project.

Figure 1.11 
View context menu

Figure 1.12 
Framing element 
context menu

Figure 1.13 
Wall element con-
text menu
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16  | Chapter  1  Inside Revit Structure

Elements
One of the important things to understand about Revit Structure in its approach to modeling is 
that it is object oriented, rather than line based as in traditional 2D drafting. Instead of drawing 
a series of lines on a flat sheet to represent a column, you go to a virtual library, load a column 
element, and then place it in your virtual working space. That column displays in every view. 
In addition to modeling elements, other element types are available to help you document your 
design, as we will discuss in this current section.

Three types of elements are used to model and document a project in Revit Structure: model 
elements, datum elements, and view-specific elements. These elements are organized in order to 
allow you to easily control their on-screen and printed appearance and display. Let’s take a look 
at these elements and how they function.

Model Elements
Beams, columns, walls, and other real-world building objects are represented in Revit Structure 
by model elements. These are the primary elements used to create the model and are typically 
placed as they would be constructed. This approach allows accurate quantities and views to be 
derived from the model. 

Model elements can be altered in any view in your project in which they appear. Once 
changed, every related view is automatically updated by the underlying database. This is called 
bidirectional associativity, and is one of the most important aspects of Revit Structure.

One of the promises of BIM technology like Revit Structure for project design is that much of 
the busywork of creating construction documents will be reduced so that you can concentrate 
on the design of the project rather than wrestling with the design software. The use of model 
elements is a good case in point. 

Two distinct types of model elements exist in Revit Structure:

Host ​  ​ Host elements are generally system families (which will be discussed later in this 
chapter) that represent real-world construction elements such as walls, slabs, roofs, and stairs. 
These elements, as their name implies, often host other elements such as openings in a wall 
or reinforcement in a slab.

Component ​  ​ Component elements are used to represent all other real-world construction 
elements, including beams, trusses, columns, and reinforcing bar. These elements are typi-
cally external families that are loaded from the Revit Structure libraries into the project as 
needed, similar to their real-world counterparts being trucked or shipped to the site for 
assembly.

Most of your modeling will use these elements, so it is important for you to understand their 
basic properties. 

Datum Elements
Grids, levels, and reference planes are datum elements. These elements provide the framework 
in which the building elements are placed and flexed. As you add your model elements to the 
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project they will become fixed to the datum elements.  These basic modeling constraints then 
become anchors for objects so that if you need to change a bay width or the story-to-story height 
of a level those elements will also move correspondingly.  For example: beam elements placed in 
a third floor plan view are associated with that datum. Changing the elevation of the level will 
take the beams along for the ride as they are defined as belonging to that level. This makes floor-
to-floor clear height adjustments quick and accurate. 

Datum elements are an essential part of a constraint-based modeling system and are funda-
mental to how you will assemble and edit the design.

View-Specific Elements
View-specific elements are used to annotate and detail specific views of the model for the cre-
ation of your construction documents:

Annotation ​  ​ Annotation elements include text notes, tags, keynotes, dimensions, spot eleva-
tions, spot coordinates, and symbols. These elements play a critical role in translating the 
model into construction documents. Unlike simple annotations found in other platforms, the 
majority of the annotation elements in Revit Structure have a great deal of intelligence. Tags, 
for example, are annotations that display specific parameter values contained in the model 
elements. Change the size of a beam in the model, and all tags that you have already placed 
will be updated automatically. Adding text is also a view-specific element (see Figures 1.14 
and 1.15).

Detail ​  ​ Detail elements pick up where the model elements leave off. Some items are not 
worth the time, effort, or performance overhead to model and can easily be handled with the 
addition of simple 2D line work or by adding 2D detail components, such as to a section cut 
through the model. These elements are used to complete in 2D the areas that are not mod-
eled but whose display aids in showing design intent.  For instance you might add 2D earth 
hatching around a foundation footing.

How Much Should I Model?

How much should you model and how much should you just add in 2D?

You need to ask yourself this question quite often as you proceed with modeling your project.  You 
might model the columns but not model the base plate and bolts in your project if you work for a 
design engineering firm. In that case, modeling a few typical cases of various connection types will 
be sufficient.

On the other hand, if you work for a detailing or construction management firm, you might have to 
model every piece in the structure. The scope and extent of your model building depends on the docu-
ments that will be derived from it, as well as the BIM solution you are trying to achieve.

The bottom line to knowing how much to model in your project is that you must maintain the essential 
integrity of the model by creating and maintaining the necessary elements to suit your purposes.

84404c01.indd   17 10/23/08   1:58:39 PM



18  | Chapter  1  Inside Revit Structure

Figure 1.14 
The gray line work 
consists of model 
elements.

Figure 1.15 
The gray line  
work consists of 
detail and datum 
components.
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As the name implies, View-Specific elements only exist in the view in which they are placed, 
with dependent views the exception to the rule. Dependent views are child views to a single 
parent view and share all view-specific elements with the parent and its other children. An 
example of a dependent view is a large framing plan that needs to be divided into several sec-
tions so it will fit onto your title sheet.

Model elements, on the other hand, appear in every view whose extent they intersect. That 
saves a lot of time and coordination effort when you are making significant changes in the 
design.  And remember you can work on the model elements in any view in which they appear.

Element Organization
All of the elements used throughout Revit are logically organized into a hierarchy of categories, 
families, types, and instances: 

The categories represent the different parts of the building, such as structural foundations, •u	

columns, and beams.

Within each category are different families of objects. The structural column category has •u	

steel column families and concrete column families.

Within each family are different types of the same object,.The steel wide flange column •u	

family has many sizes, such as a W12x26 and a W24x55. These are different types of  
one family.

Each type can be placed many times in your project, and with various settings, which we •u	

call instances of a type. One instance may be a one-story column; another instance may be 
a four-story column.

Next we will examine these different parts of the element organization and how they work 
together in your virtual model as you work through the design process.

Categories
The basic set of object categories can be viewed and edited in the following way:

	 1.	 On the menu bar, click Settings  Object Styles, or on the menu bar click View   
Visibility/Graphics. 

	 2.	 In the resulting dialog box, click the Object Styles button at the bottom.

Figure 1.16 shows the Object Styles dialog box. Checking the Show Categories from All 
Disciplines check box will allow you to see additional categories primarily used by the Revit 
Architecture and Revit MEP platforms. This dialog box organizes the categories into three tabs: 
Model Objects, Annotation Objects, and Imported Objects.
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Families 
The object categories are divided into families. Families can be system, in-place, or external. 
System families are built into templates and projects, and in most cases cannot be completely 
removed. System families can be:

Model elements (walls, columns)•u	

Datum elements (grids and levels)•u	

View-specific elements (text notes, tags)•u	

System families are easily identified by checking the family name of an element in the Element 
Properties dialog box. The name of the family is prefaced by System Family (see Figure 1.17).

External families are loaded from the Revit Structure content libraries as well as from your own 
custom created libraries. You load them in as you need them. These family files can be created 
from scratch using a default template shipped with the program, by using a custom template, or 
by copying and modifying a similar existing family. 

Figure 1.16 
The Object Styles 
dialog box provides 
display controls 
 for element  
categories.

Figure 1.17 
The name of the 
family is prefaced 
by System Family.
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Use the Built-In Libraries TO Your Advantage

Copying and modifying the built-in library families is a great way to learn how families are created, 
and to begin experimenting with your own adaptations. Learning to adapt and create families will 
prove to be a big benefit for you.

External families can be:

Model elements (columns and beams)•u	

View-specific elements (tags and detail components)•u	

In-place families are primarily used for custom project-specific applications. As the name 
suggests, these families are built in-place within the project. One possible application for an in-
place family would be a void family used to cut an odd-shaped opening in a wall.

Types
Families are further divided into types. A family may have one or more types. A column 

family (model element) type would be a W12x40. A grid family (datum element) type would be 
a 1⁄4˝ Bubble. A structural framing tag family (view-specific element) type would be Boxed.

Instances
An instance is a specific element of a given family type. For example, for a model element of 
the Category Structural Column, whose Family is a W-Wide Flange Column and whose Type is 
a W12x40, the instance would be the specific W12x40 located at the grid intersection A-1 from 
Level 1 to 4́ -0˝ above Level 2.

Element Properties Dialog Box
As you are placing objects such as columns and beams into your building model, you can access 
the properties of each one by highlighting it and clicking the Properties button on the Options bar 
(next to the Type Selector), which will open the Element Properties dialog box (see Figure 1.18).

Elements can also be accessed in other ways. With the element(s) selected:

Right-click, then select Element Properties.•u	

From the menu bar, choose Edit •u	  Properties.

Press Alt+Enter on your keyboard.•u	

Press the default shortcut PR. •u	
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This dialog box contains the parameters that define the element, and is broken into two main 
areas: instance and type parameters.  It can be used to change their values in the following ways: 

Changes made to the instance parameters will only affect the element(s) that you have •u	

selected. 

Changes made to the type parameters affect every instance of the element that you have in •u	

the model whether you have selected it or not.

Now that you have studied the various elements that are available to you for modeling your 
structure, let’s examine how those elements are displayed in your model. The views that you 
create, their interaction, and how they display the elements in the model are important consider-
ations in the evolution of any project.

Project Views and Display
There are numerous types of views that are created as you are working. Each View type serves 
a variety of purposes within your project. You access these views through the Project Browser 
and display them in the drawing area. In this section, we will introduce you to these various 
view types with a brief explanation of how they work.

Plan, elevation, callout, section, and 3D views act as direct graphical “windows” to the model. •u	

View-specific elements such as notes and member tags can then be placed and the graphi-•u	

cal display of elements can be manipulated in these views without any effect on the actual 
model or other views. Modifications can be made directly to the model elements in any of 

Figure 1.18 
Element Properties 
dialog box
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these views, and those modifications will be instantaneously propagated to all other 
relevant views (as you will recall, this is called bidirectional associativity).

Drafting views are somewhat detached from the model itself, but they play a valuable role •u	

in the development of construction documents. 

Sheet views are a specialized view that typically contains one or more other view types •u	

and your title block.  They are used for creating your finished construction documents and 
presentation drawings.

Now let’s look at each one of these view types and see how they can be created in your project.

Plans
One thing to understand about plan views is their relationship to the levels you create. A new 
plan view is not automatically added to the Project Browser every time you draw a new level in 
your project. Copying an existing level to create a new one will not automatically create a plan 
view. In these cases, you must create the view after the level is created.

To create a new plan view for a level that does not currently have one, follow these steps:

	 1.	 Select the Floor Plan command from the View tab of the Design bar, or from the menu 
bar select View  New  Floor Plan. 

	 2.	 Select one or more levels to create plan views in the New Plan dialog box (see Figure 1.19). 

 If you are using this method to create a duplicate plan, be sure the Do Not Duplicate Existing 
Views check box is not selected. Also note that you can preset the scale of the plans being created.

Figure 1.19 
New Plan  
dialog box
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You can duplicate plans by right-clicking a plan view name in the Project Browser and select-
ing Duplicate View from the context menu. A fly-out menu (see Figure 1.20) will appear with 
three options: 

Duplicate•u	

Duplicate with Detailing•u	

Duplicate as a Dependent•u	

These three ways to duplicate views work like this:

Duplicate will create a new plan view that is an exact copy, displaying all datum and model •u	

elements. No view-specific elements (such as text) will be copied with this option. 

Duplicate with Detailing works the same way except that all view-specific elements are •u	

also copied. 

Duplicate as a Dependent will create a child view to the selected parent view. Any number •u	

of dependent views can be created from a single parent view. This feature was added to 
facilitate the division of large overall plan views into smaller views for placement on 
sheets. All view-specific elements are shared between the parent and all child views.

View Range
View Range is important to understand when you are dealing with plan views since it controls 
the basic vertical range above and below the elevation that your view is cut through the model. 
You access the View Range properties by clicking View Range in the View Properties dialog box 
of that particular plan view. The resulting View Range dialog box (see Figure 1.21) is used to 
control element visibility and display that is perpendicular to the plan view.

Figure 1.20 
You can use Dupli-
cate View to create 
copies of a view.

Figure 1.21 
View Range  
dialog box
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The primary range is defined by three horizontal planes: top, cut, and bottom. A fourth plane 
that can exist outside the primary range is the view depth. The cut plane is always defined as an 
offset of the view’s associated level. The other three planes may be defined relative to any level 
in the model or set to Unlimited.  The top and bottom planes of the view range define the pri-
mary vertical extents of the model that is displayed in the view:

Model elements that fall within the primary range and that are not cut by the cut plane will •u	

display their projection line style as configured in the Visibility Graphics dialog box. 

Elements that are cut by the cut plane will display their cut line style (if they have one), as •u	

configured in the Visibility Graphics dialog box.

Cut Lines and Patterns

Whether or not a cut line or pattern style exists for a particular category can be verified in the Object 
Styles or Visibility/Graphic Overrides dialog box (see Figure 1.22 later in this chapter).

Categories that have a shaded cell in the Cut-Lines column do not have a definable cut line style.

Elements that are outside of the primary range but fall within the extents of the view depth 
will be displayed with the Beyond line style. The Beyond line style is defined in the Line Styles 
dialog box, which you open by choosing Settings  Line Styles from the menu bar.

You might wonder where you would use the Beyond line style. The most obvious example is 
an architectural roof plan. Usually the architectural plan displays the roofs looking down from 
above the building on all the roof levels below. You can have a roof at the second floor and a roof 
at the sixth floor showing in one plan view. To do that, you extend the view depth down to the 
second floor so that all the roofs are within the range, and you can give it a specific line style to 
distinguish it as being beyond the view cut plane.

Multiple-View Concept

Although it may not seem natural at first, a good practice to adopt while working with views in Revit 
Structure is to create multiple copies of the same view to be used for specific purposes. When dealing 
with plan views, you will typically have at least three views for each level.

Using the second level of the model as an example, you can create the following views: S-FP02, S-FP02-
Analytical, and S-FP02-Working. The S-FP02 view would be placed on a sheet view and will ultimately 
be plotted as part of the construction documents. The graphical displays of the datum and model ele-
ments in this view are always set as they are intended to plot. Only construction document view–spe-
cific elements are added to this view. The S-FP02-Analytical view is used to display an analytical view 
of the model elements. S-FP02-Working is typically used to coordinate with the other disciplines by 
linking in models and DWG backgrounds or to adjust the display of elements to troubleshoot the model. 
Annotations can be placed in either of these views as reminders or notes to other team members.

Working in this manner helps safeguard the integrity of the construction documents without hinder-
ing productivity. 
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Callouts
Callout views are used to produce a blow-up of an area for clarification and can be accessed on 
the Design bar on the View tab. This usually larger-scale view is used to show a higher level of 
detail and additional annotation that may not be legible at the original scale.

Three distinct types of callouts are available: reference, detail, and view. 
Reference callouts are ideal for tying in standard details (drafting views) or to refer to a 

similar existing view. Reference callouts do not create a view in the project; instead they are tied 
directly to the existing view they reference. You place reference views by selecting the callout 
command from the View tab and selecting the Reference Other View box on the Options bar. 
Then, select a view to reference from the drop-down menu on the Options bar. Finish by draw-
ing the callout graphic in a view.

You place detail and view callouts by selecting the callout command from View tab of the 
Design bar. Then select the appropriate callout type from the Type Selector, and finish by draw-
ing the callout graphic in a view. Detail callouts will place a new view under the Detail Views 
(Detail) heading in the Project Browser. Detail views are typically used to embellish another 
detail or section at a larger scale. View callouts will place a new view under the same heading 
as the view it was created in. View callouts have all of the same capabilities as the view to which 
they refer. This makes them ideal candidates for enlarged plans.

Sections
Section views cut vertically through the model. These views are created for many purposes, 
but mostly for wall and building sections. The section updates automatically with any new or 
modified model elements falling within its scope (that is, its length and depth). Other sections 
that fall within that scope are also displayed by default. That makes referencing mistakes much 
less likely to occur, and saves you a lot of valuable time that you might otherwise spend cross-
referencing details.

During the course of modeling or troubleshooting, it is often useful to cut a working sec-
tion. These working views are not intended to be placed on the construction documents and are 
essentially disposable. To keep the Project Browser organized and the construction documents 
free of “view clutter,” it’s a good idea to create a new section view type that is easily identifiable. 
You need to be careful not to move sections that you have placed on sheets.

Sections views that that have not been dragged onto a sheet and thus are not referenced on 
any sheet will not print, so making working sections and leaving them at print time is fine. But 
if you export your model to an AutoCAD DWG file, the unreferenced section callouts will be 
exported, so you will have to do a little cleanup of the DWG and erase them before you send 
it out, especially if it is an important design submission.  So it is better to erase those sections 
before you export your sheets.

To add a section, perform these steps:

	 1.	 Click Section on the View tab.

	 2.	 Click on the location you wish to begin the section.

	 3.	 Click where you want to finish the section.

	 4.	 Highlight the section, which will display a dashed green line. 

	 5.	 Click the grips and drag the dashed green line line box to adjust the depth of the section.
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Elevations
Two types of elevations are available in Revit Structure: building and framing.

You create building elevations by selecting the Elevation command from the View tab of the 
Design bar and placing the view tag in a plan view. 

Building elevations are similar to section views but are located under a separate heading in 
the Project Browser. Each instance is capable of generating the four directional views.

Framing elevations are specialized elevations designed to facilitate the placement of verti-
cal bracing and moment frames. You create these elevations by selecting the Framing Elevation 
command from the View tab of the Design bar and selecting a grid or named reference plane in 
a plan view to attach the elevation view tag. You can place the elevation view tag on either side 
of the grid or named reference plane; it depends on which side of the element you are prior to 
placement.

Drafting
Drafting views are 2D views that have no connection to the 3D model. To work in the drafting 
views, you will use the drafting tools found on the Drafting tab of the Design bar, such as Detail 
Lines and Filled Regions.

A good example of a drafting view is a typical detail that you wish to add, or an imported 
scan. Detail views can be saved and inserted from detail libraries either individually or as whole 
sheets, as you will see later in Chapter 10.

Legends
Legends are unique views which have the advantage that they are the only view types that can 
be placed on multiple sheets. You create a legend by selecting the Legend command from the 
View tab of the Design bar. Legends views are typically used as an explanatory list of symbols 
and text that are found in the project. Chapter 10 will discuss alternative uses for legend views 
and step you through the creation of a legend.

Schedules
With the exception of the Graphical Column Schedule, schedules are typically spreadsheet-style, 
text-based views that report the quantities of specific elements or the values of an element’s 
parameters. You create a schedule by selecting either the Schedule/Quantities or the Graphical 
Column Schedule command from the View tab of the Design bar.

Creating schedules will be discussed in depth in Chapter 11.

3D
Three-dimensional (3D) views allow you to orbit around your model in 3D space in order to 
view the overall model. You can activate a section box that you use to create cutaway views 
through any portion of the overall model. 3D views are very important for visualization pur-
poses, both for the client and the working engineer or draftsperson.  When you start your 
project it is good practice to immediately create a sheet of 3D views to share with your client.  It 
immediately creates a better understanding of the structure, especially for an owner who has no 
experience with reading plans and sections.
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Sheets
Sheet views contain your title blocks, and they are the assembly point for all the different views 
you create: plans, sections, elevations, and so forth. You drag the different views you have cre-
ated onto the title sheet and position them as necessary. When you add a sheet view to your 
project, you will be prompted to select a title block to use for the new sheet. The title block itself 
is a separate file that you load into your project. You will learn more about title sheet creation in 
Chapter 12.

Plan Region
Plan regions are self-contained view ranges within a plan view and are used in those cases 
where you need the view range of a particular area on a plan to differ from the overall plan 
view range. Remember that the view range sets the vertical range above and below the elevation 
at which your plan view is cut.  An example of this is an area with a stepped footing that is step-
ping out of the vertical range. If you want to control exactly which step to display on the overall 
plan, you use a plan region to adjust where the stepped footing cuts off in the view.

When you start the command you are put into Sketch mode.  To create a plan region, simply 
sketch the area you wish it to affect.  Then adjust the view range parameter in the View Proper-
ties dialog box to suit your needs.

Visibility/Graphic Overrides Dialog Box
The Visibility/Graphic Overrides dialog box (see Figure 1.22) provides a way to change the dis-
play of elements for a specific view. 

The changes made in this dialog box have no effect on the model itself or any other views, 
including any dependent views and the current view. If your intention is to change the look 
of elements project wide, see the appropriate dialog boxes outlined in the upcoming section, 
“Graphic Standards.” Line style settings are located in the Visibility/Graphics Overrides dialog 
box. For easy access, press VG to access these settings, as you will be in and out of this dialog 
box constantly.

Figure 1.22 
Visibility/Graphic 
Overrides  
dialog box
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The Importance of Display Control

Remember that display control is half the effort that must be expended toward the goal of getting a 
good-looking set of construction documents from your model, like the sheet of plans in the graphic 
below. It is easy to get caught up with building the model and neglect setting up and creating  the 
documents that must be derived from it. At the beginning of the project, start thinking about how you 
will organize your different views onto sheets and how you want each view displayed.  Set up your title 
block and start adding sheets as soon as possible.  You should be asking yourself questions such as what 
detail mode and view scale is appropriate, and how much of the model should a certain view expose. 

Getting your modeled elements to “look right” on the final document can be a frustrating task and 
requires special attention to the methods that will be discussed. So keep your deadlines in mind and 
schedule your time accordingly so that you are not only modeling but also creating your documents 
in a wise manner.

Now that you have studied the various views that are available to you for displaying your 
virtual structure, we’ll show you how to adjust the graphical settings within those views to best 
display the elements in your final documents.

Graphic Standards
What if you want increase the cut line width of your structural columns and have it change in 
every view of the project, not just in the current view? 

The graphical display of elements throughout all views of a project is efficiently managed with 
a handful of dialog boxes. This dynamic ability to modify project standards on the fly during 
production is a major benefit of the Revit Structure platform.  You will now explore the different 
ways that you can effectively configure and control your element displays.
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Object Styles
One of the most important of these dialog boxes is the Object Styes dialog box.  In the Object 
Styles dialog box, you assign and control the following:

Line weights (both projection and cut)•u	

Line colors •u	

Line patterns•u	

Material styles•u	

This dialog box controls the display of all categories and subcategories of elements in the 
project model. You organize and modify these styles using the Object Styles dialog box (see 
Figure 1.23), which you access by clicking Settings  Object Styles or via the Visibility/Graphic 
Overrides dialog box. There you can access and edit the various display parameters, such as cut 
line and projected line weights.

Material Styles
The Materials dialog box allows you to configure and control all the material assignments for 
elements in your model.  For instance, what grade of steel do you want your columns to be and 
in what color do you want it displayed in a 3D view?

Open the Materials dialog box (see Figure 1.24) by choosing Settings  Materials from the 
menu bar. This dialog box lists all of the materials currently available in the project: 

The Graphics tab defines the appearance of the material in all nonrendered views. •u	

The Render Appearance tab, as the name suggests, contains settings that define how the •u	

materials will appear when rendered. 

Figure 1.23 
Object Styles  
dialog box
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The Identity tab contains parameters that can be specified for each material that can be •u	

leveraged by tags and schedules. 

The Physical tab contains structural information that can be leveraged for the structural •u	

analysis of the model.

Line Styles
Line Styles are used mostly for 2D drafting and for using the Linework tool.  There are many 
default styles. Nine of those cannot be deleted.  Beyond that you can create your own line styles.

Open the Line Styles dialog box (see Figure 1.25) by choosing Settings  Line Styles from the 
menu bar. This dialog box lets you view and edit all of the line styles available in the project.

Line Weights
You define line weights using the Line Weights dialog box (see Figure 1.26). Open this dialog 
box by choosing Settings  Line Weights from the menu bar. Line weights are divided into 
three categories: Model, Perspective, and Annotation. Sixteen line weights can be defined for 
each of these categories. The Model category can have unique weights for each of the predefined 
28 imperial or 12 metric scales. Weights defined for the perspective and annotation categories 
are absolute, regardless of scale.

Figure 1.24 
Materials  
dialog box
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Line Weight Adjustments

Different plotters may require adjustment of the default line weights in order to get a better print. In 
some cases, the thinnest pen weights will not display well on certain plotters, so you should experi-
ment with different values to see which are best for your particular output device.

Figure 1.25 
Line Styles  
dialog box

Figure 1.26 
Line Weights  
dialog box
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Line Patterns
Line patterns are a sequence of dots, dashes, and spaces of various lengths that create distinct 
lines. The Line Patterns dialog box (see Figure 1.27) can be accessed from the menu bar; simply 
choose Settings  Line Patterns. 

Clicking the New or Edit button in this dialog box will take you to the Line Pattern Proper-
ties dialog box (see Figure 1.28). Here you can develop new line patterns or adjust existing ones 
in order to perfect the different view displays.

Fill Patterns
Fill patterns are used by filled regions for hatching.  They are also used by materials for both 
surface and cut patterns of objects. All of the fill patterns can be viewed and edited in the Fill 
Patterns dialog box (see Figure 1.29). To open this dialog box, choose Settings  Fill Patterns 
from the menu bar. Revit Structure offers two types of fill patterns: drafting and model. Model 
elements scale with the object and represent the real-world appearance of an object, like CMU 
(concrete masonry units) coursing. Drafting patterns do not scale and are a symbolic representa-
tion of a material such as the concrete pattern.

Figure 1.27 
Line Patterns  
dialog box

Figure 1.28 
Line Pattern Prop-
erties dialog box
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Clicking the New or Edit button in this dialog box which will take you to the Modify Pattern 
Properties dialog box (see Figure 1.30). Here you can develop new patterns or modify existing ones.

That completes your first look at the Revit Structure interface and its basic set of commands.  
In the next chapter you will learn how to develop different project environments through the 
use of templates. We will discuss the various settings that are available to you as well as how 
the Project Browser can be organized so it can be managed. In the end we will discuss how con-
tent and settings can be transferred from one project to another.

Figure 1.29 
Fill Patterns  
dialog box

Figure 1.30 
Modify Pattern 
Properties  
dialog box
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The Bottom Line

Use the graphical user interface. ​  ​ The Revit Structure GUI is an easy way to interact with 
your computer in order to efficiently create your project model and documents.

Master It ​  ​ There are several ways to launch a single command in Revit Structure. List 
the various ways in which the Beam command can be invoked. Which method is the 
quickest?

Understand the types of elements in the modeling environment. ​  ​ In the modeling envi-
ronment, there are basic types of model and annotation elements that you use in the con-
struction of the virtual model and construction documents that you derive from the model.

Master It ​  ​ Modeled elements have a defined hierarchy that consists of categories, fami-
lies, types, and instances. Use a structural column and give examples of each of these 
four element properties.

Create and manage project views. ​  ​ Even though you are building a 3D model, most of the 
time you are working in 2D views such as plans and sections. Therefore, the view types 
become your working planes and must be sensibly arranged.

Master It ​  ​ List all the major project view types discussed in this chapter.

Control the graphical display of elements in a project. ​  ​ Creating the model is only half the 
story. Then you must derive the 2D and 3D views you will need for your construction docu-
ments. Each of these views must be able to display the model, and those display controls are 
an essential subject to understand.

Master It ​  ​ In your project you want to change the look of your masonry units on plans 
and elevations to match your company standards. Explain how to change the cut pattern 
for Concrete Masonry units to a diagonal pattern and the surface pattern to 8 × 8 block.
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